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Introduction 

 

Welcome to the Sage user guide for Oxatis Link for Sage 100 i7  

 

The Oxatis Link automatically exchanges data between your Sage business software and your e-Commerce site(s) for Sage 

SQL i7 100 (express or Server). 

 The first two introductory chapters will give you an overview of new features and provide general information on the 

Oxatis Link for Sage. 

The Oxatis Link for Sage features are presented in order of their implementation, starting with the configuration, after 

which we will present the three exchange assistants: import articles, import customers to the Oxatis website and export 

online orders to your Sage Business Management software.  

The final chapter discusses the advanced functions of the connector requiring special attention because of the complexity, 

or at least because of the large variety of management situations that may be met. 

 

This guide was written to provide you a practical manual on how to work with the Oxatis Link on a daily basis. If any 

questions arise after reading this guide, or if you encounter any unforeseen problems, do not hesitate to contact our 

Support team. We are at your disposal seven days a week, all-year round to help you succeed in e-Commerce. 

 

 

Regards, 

The Oxatis team 
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NEWS 

With the Oxatis Link for Sage, you can perfectly integrate your online business with your Sage 100 Business Management 

software.  

As Sage’s exclusive e-Commerce partner, Oxatis experts have developed two specific links connecting Sage 100 i7 business 

software to your e-Commerce site and enabling for a full B2B e-Commerce integration with Sage 100 v8 i7. 

 

The main innovations that will optimise your online business management: 

 

Discount and pricing strategies 

- Multi-pricing: Apply discounts, promotions and tailored pricing to multiple customers 
- Discount strategies: Submit levels of tariffs and discounts (special price, discount per tariff category, applied discounts for 
article groups and customers). 
 - Prioritise discounts (discount per article, families, users, cumulative or cascading discounts) 
- Purchasing price: Manage the pricing for your customers related to a purchasing center 
- Discount type: Set various types of discounts (simple percentage, quantity discount, discount percentage on the amount 
ordered, net price, price before discount). 
 
Synchronisation of manufacturing type products and compound articles (packs) 
To meet your needs in B to B sales, the new Sage 100 Trading i7 v7.70 and i7 v8 Links allow for the creation of new 
compound articles (packs) which are automatically connected to your ERP: 
- Parts list articles such as "Manufacture" or "Composed": your packs are managed as standard articles, simplifying entering 
quotes. 
- Varying Packs with the catalogue configurator option: personalisation of content and pack value. 
 
Improved analytical follow-up 
To give you an accurate overview of your business activities, the Oxatis solution has added Sage 100 Trading i7 features to 
its Link 
- Real Stock, available in the long run 
- Single shop customer 
- Order origins (store, Amazon, eBay) associated with Sage business codes 
- Increased number of data to be associated (visible article, article order)  
 

These developments appear on two levels: The Link uploads and transforms the data from Sage to Oxatis and from Oxatis 
to Sage, and at the level of the Oxatis Internet solution which is enriched with new data, features and algorithms. 
 

The details of the changes are presented next. 

  

https://www.actinic.co.uk/erp-sage-ecommerce.htm
https://www.actinic.co.uk/create-b2b-online-shop.html
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Oxatis DataPlug v6.40: Bugfixes and new features 

 

 Article import:  
o The characteristics or facets from the free fields in Sage will now take in account the chosen separator to set 

apart the different options per characteristic. 

o Images already present in the Dataplug will not be reimported.  

Migration Sage eBusiness: The filter display of the migrated articles appears even when the descriptions import box is left 

unchecked. 

 

d’Oxatis DataPlug v6.35: Bugfixes and new features 

 

 Oxatis Link for Sage 100 ERP i7 v7.70 & v8.0 

 Articles Import : 

o Characteristics management:  

 The table for common language characteristics was deleted. 

 When not importing an article, the options become inaccessible.  

 Sage eBusiness : 

o Special characters were transformed:  $, %, ’, -, @, ~, ‘, !, (, ), ^, #, &, +, ;, =, [, ], . and , and _ 

(underscore) to detect images and descriptions in HTML 

 

Oxatis DataPlug v6.30: Bugfixes and new features 

 

 Oxatis Link for Sage 100 ERP i7 v7.70 & v8.0 

 Articles import: 

o New characteristics management: It is now possible to associate one or more open fields from the 

articles table (Sage) to the characteristics (Oxatis) and for both there are two options   

 Or the characteristics value is the same in every language. 

 Or the characteristic values are different and need to be translated from the Oxatis Back 

office. 

o Unlimited choice of deposits 

 Order export: 

o The “state, region and province” fields can be associated to an open entry field of the Sage document. 

 The system will stop proposing the installation of the Business Object extension pack after this pack has been 

installed. 

 It is now possible to filter-out the to be migrated articles from Sage eBusiness in order to establish a grouped 

migration. Il est possible de filtrer les articles qui sont concernés par la migration Sage eBusiness et ainsi de 

réaliser la migration famille d’article par famille d’article. 

 

Oxatis DataPlug v6.30: Bugfixes and new features: 

 

 Oxatis Link for Sage 100 Trading i7 v7.70 & v8.0 

 Articles import: 

o New characteristics management: It is now possible to associate one or more open fields from the 

articles table (Sage) to the characteristics (Oxatis) and for both of them there are two options:  

 Or the characteristic value is the same in every language, 

 Or the characteristic value is different and needs to be translated from the Oxatis Back office. 

o Unlimited choice of warehouses 

 Export orders: 

o The “state, region and province” fields can be associated to an open entry field in the header of the 

Sage document. 

 The system will stop proposing the installation of the Business Object extension pack after this pack has been 

installed. 
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 It is now possible to filter-out the to be migrated articles from Sage eBusiness in order to establish a grouped 

migration. It is possible to filter the articles that are affected by the migration Sage eBusiness and so achieve the 

article migration by article family. 

Oxatis DataPlug v6.00: new features: 

 

 Oxatis Link for Sage 100 Trading i7 v8 (New) 

New installation that loads the v6 business objects. 

 

 Oxatis Link for Sage 100 Trading i7 v7.70 & v8.0 

 Import articles: possibility of assigning packaging to each of the 10 prices in Oxatis. 

 Export orders: It is possible to assign to the Oxatis orders separate centralising customer accounts for domestic 

sales, EU sales excluding tax, EU sales with tax and export sales. 

 
Oxatis DataPlug v5.45: new features: 

 

 Importing customers:  

 The VAT number in the fields is cleared before import.  

 Delivery addresses are ignored for countries which ISO code is not defined. 

 

Oxatis DataPlug v5.14 : New Features 

 

 Importing customers / articles: A new checkbox "View strikethrough prices" has been added to help manage the 

display of strikethrough prices regarding the discounts rules associated to special rates. 

 Import articles: the checkbox "Do not apply any other discount on articles" becomes active on Oxatis when the price 

categories of Sage articles define discount rules with net prices.  

 The maximum number of imported shipping addresses is increased to 50 addresses per customer.  

 Exporting orders: 

 Delivery address creation in the Sage customer file: The fields "Supplement" and "Address" are no longer 

reversed. 

 The customer contact is included in the document information. 

 

Oxatis DataPlug v5.11: New 

 

 Importing articles: Only articles with a single VAT rate (plus environmental taxes) are imported. 

 Delivery address creation within Sage 100 customer files: The fields "Supplement" and "Address" are no 

longer reversed. 

 

 

Oxatis DataPlug v5.1: Bugfixes and features 

 

 Importing customers/contacts :  

 Possibility to choose to import customers and / or contacts and to filter the types of contacts. 

 You can import up to 25 shipping addresses for each of the contacts / customers. 

 Managing discount priorities for special rates: Discount per article or per family or customer discount, 

cumulative rebates or cascading discounts. 

 Exporting orders:  

 A new checkbox has been added to allow the wizard to assign the warehouse to the client. 

 Involve the new articles created in the database Sage GC to an existing family. 

 Standard Oxatis payment methods will be associated with the payment method "Other" Sage. 

 

 Bugfixes:  

 Special price recovery problem for a double range article. 

 Excluding articles with a negative price. 
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Oxatis DataPlug v5.0: 

 Exporting orders: 
 Affect the customer’s warehouse to the order  
 Association of standard payment method to "Other" 
 Attach new articles created in Sage to an existing family  
 Clear the association between Sage delivery options and Oxatis' delivery option 

 

 Importing users: 

 import customers, contacts or both 

 Import additional delivery addresses for a customer 

 Selection of services attached to contacts 

 Prioritising the application of discounts (Discount articles, families, users, combined or cascading) 

 

Oxatis DataPlug v4.97: Bugfixes and new features 
 New Backup and Restore function for the DataPlug including the database, images and all directories located in the 

C:\ProgramData\Oxatis\DATA. 

 Task scheduler: 

 The tasks are executed in the following order:  

o Oxatis orders are downloaded 

o Orders are exported to Sage 

o Articles are imported from Sage  

o Articles are uploaded to Oxatis 

o Sage customers are imported 

o Customers are uploaded to Oxatis 

 Importing articles: 

 New columns for the optional B to B mode: 

o Extension of existing prices, "Price 6 excl. Tax" to "Price 10 excl. Tax " and "Price 6 incl. Tax" to "Price 

10 incl. Tax" 

o Extension of existing strikethrough prices "Strikethrough price 6 excl. Tax" to "Strikethrough price 10 

excl. Tax " and "strikethrough price 6 incl. Tax" to "strikethrough price 10 incl. Tax" 

o "Rule discount rate 1" to "discount Price Rule 10 'option to enter the name of the discount rules for 

each of the prices (1-10). 

 Import articles parts list "Sales / assembly" or "Manufacturing". 

 New option to make web articles invisible for dormant articles. 

 Possibility of considering future stock. 

 Extension of linked price categories (up to 10 prices). 

 Importing rebate rules for each of the price categories. 

 • Importing users: 

 Import discounts by article family and special prices. 

  Exporting orders:  

 Ability to generate text attributes in Sage order entry fields. 

 Sage Analytics: Linking orders and their source (Store, Facebook, Amazon, eBay, etc) with Sage business codes 

 Possibility to keep the same customer account in case of change of billing country. 

 Selecting the status of the document to generate (" Recorded", "Confirmed" or " To prepare" as standard or 

customised labels). 

 Creating articles in the Sage database is no longer active by default. 

 Creating articles with parts lists in the in Sage generated order. 

 Possibility to regroup store customers (excluding credit customers). 

 Migrating from Sage e-Business: 

 Permits to fill the "Description" and "Long description" fields of Oxatis Articles from the html files in Sage e-

Commerce. 

 The migration wizard offers the choice of the directory containing the HTML descriptions and the selecting of 

the level "cleaning" the HTML content. 
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o Minimum: Only the header of the HTML files is not recuperated. This option allows to keep the Sage 

e-Commerce format but can cause broken links or images. 

o Partial: The images, links and scripts tags are removed. 

o Complete: All HTML tags are removed, only the textual information is retained. 

 Links the images used in Sage e-Commerce to Oxatis articles. 

 The migration wizard offers the choice of the directory containing the images that will be associated with the 

article. The image creation process is identical to that which exists in the DataPlug. 

 Articles which have descriptions and images in Sage e-Commerce can be pushed towards the Oxatis solution. 
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1. General information on the Oxatis Link for Sage  

 The DataPlug  is the tool which imports articles, user customers and orders between Oxatis e-Commerce and 

local files (.csv, .xml, .jpg). The Dataplug uses web services to communicate with the Oxatis e-Commerce site. 

 Oxatis developed the Sage 100 Trading Link to propose a direct synchronisation of articles, customers and orders, 

using a Sage database to SQL Server or SQL Express. The Link integrates with the DataPlug menu to optimise the 

data upload. The technologies used to communicate with the Sage database are the Microsoft SQL Server and the 

Sage Business Object extension pack. 

 The Link installation-guide and user-guide can be downloaded from the "Help" menu. ». They are also available at 

the following address:  

  

http://www.oxatis.com/Help/HelpCenter.asp?ActionID=512&TID=55267&MID=55254 

 

 

 
 

 A detailed user guide and installation guide are part of this manual. 

 The DataPlug online helpfiles are complementary to this guide. You can access these files from your back office. 

You can also find them here:  

http://www.oxatis.com/Help/HelpCenter.asp?ActionID=512&TID=55267&MID=55254 

 

With this blue icon, you will find expert help and advice  
 

 

 
This orange icon means: Be careful, this action may impact your Link. 

  

http://www.oxatis.com/Help/HelpCenter.asp?ActionID=512&TID=55267&MID=55254
http://www.oxatis.com/Help/HelpCenter.asp?ActionID=512&TID=55267&MID=55254
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2. Installation, update and backup 

This chapter describes how to install the DataPlug and the Oxatis Link for Sage step by step. 

Installation 
 The Oxatis DataPlug installation requires Microsoft.net Framework 4.0 

 

  The Oxatis Link for Sage and the DataPlug require: 

 The acquisition and installation of Oxatis DataPlug for Sage 100 Trading i7 SQL Server version ( 

"OxatisDataPlugSetupFR.msi"). 

 The acquisition and installation of the Oxatis link for Sage  ( "Oxatis_ConnecteurSage100vX_XX.msi"). 

 Activation of Sage 100 Trading i7 with the Business Objects extension pack key provided by Sage (standard 

in the Sage 100 Enterprise versions and available in modular versions - Verification or modification is 

performed on the following path: "? > About i7 Trading: > Key ") 

 

 The configuration of the Oxatis DataPlug requires knowledge of:  

 the location of the Sage software database(.GCM);  

 the access code and database password with sufficient rights to read and write data on articles, customers 

and orders;  

 the access code and password to the Oxatis e-commerce site;  

 ideally an image of a minimum of 600 pixels for each article description to be published on the site. 

Otherwise, it is also possible to integrate images from a photo directory. 

 

 Run the installer DataPlug " OxatisDataPlugSetupFR.msi " 

 Accept the License Agreement. 

 Select installation folder 

 Select " Just me " if only the user session in progress can use the Dataplug, or if all users on the devise will 

use the DataPlug, select  "Everybody " 

 

To share the database and to allow the change of user, prefer - a remote desktop session with an installation for "Just me ". 

This session can then alternately be used by several people who have access. It also allows the DataPlug, when the session is 

not stopped, to run in the background and continue to synchronise data exchange continuously with the task scheduler. 

- a shared PC with an installation for " Everybody " allows access to the DataPlug from multiple Windows sessions on a single 

computer. 

. 

 

 Start Installation wizard for the Oxatis Link " Oxatis_ConnecteurSage100vX_XX.msi " : 

 Select installation folder 

 Choose the same access rights for DataPlug " Just me " or " Everybody " 

 Accept the Sage Business Objects installation 

 

The installation order does not matter.  

The installation of "Sage Business Objects " can be cancelled if the component is already installed on the computer. They 

must be in the correct version. 

 

 

 A shortcut is created automatically on the user's desktop 
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 Upon first use, it is advisable to start the DataPlug with right-click " Run as Administrator "From the list of 

Windows programs or the program location: e.g. (C: \ Program Files (x86) \ Oxatis \ DataPlug) 

 

 A summary of the prerequisites for the Link is available here 

Updates 
 

 In Tools>DataPlug> General settings you can check the availability of any updates: 

 

 

 

 If the option is activated an icon will appear, indicating the availability of an update, otherwise you must manually 

check in Tools> Check for Oxatis DataPlug updates: 

 

 Clicking on the DataPlug icon automatically updates the DataPlug to its latest version. 

 

Once the new version installed, it is recommended to use different import and export wizards to check the various 

configuration settings and discover the default settings of the newly available features.  

It is recommended to select and activate the Task Scheduler. 

 

 

 

 

 

 

 

http://support.oxatis.com/PBCPPlayer.asp?ADContext=1&ID=1695535
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Backup 
 

It is important to periodically backup the database from the menu Tools> DataPlug Database> Backup. 

 

The directory C: \ ProgramData \Oxatis  which contains in particular the database and user preferences, should ideally be 

integrated into a company's data backup plan. 

Note the different customers / users and articles import settings and the order export settings. The update can affect some 

fields because of the arrival of new features. 

 

3. CONFIGURATION 

Selecting the Sage 100 Trading i7 file 
 

 

 Launch the DataPlug (a shortcut is automatically created on the desktop of the workstation during the 

installation phase). The program is also accessible from the list of Windows programs. 

 

 

Choose Configuration in the menu Links > Sage 100 Trading i7 

 

 

Enter the path of the trade file (* .GCM) for Sage i7 100 Commercial Management or click on the  

button to locate it. You must also enter the username and password set in the Administrator folder and 

leave the password field open if the Trading folder wasn't customised.  

The button Test Connection will validate the connection setup in the Sage 100 Trading i7 folder. 
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Automation with the Task Scheduler 
 

The operations presented in this manual such as the Sage data import, the data upload to Oxatis, downloading orders 

and exporting orders to Sage, are tasks that may be performed automatically with a programmed schedule.  

 

To do this, choose Connectors> Sage 100 Trading i7 8.0> Configuration in the Dataplug menu, then select Task 

Scheduler. 

 

 

 

 
 

 
 

In this tab, you can schedule automatic tasks.  
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This involves: 

 Enabling at least one of the available tasks 

 Enabling at least one day of the week 

 Defining the delay (standard 24 hours) 

 Defining an execution interval in minutes (standard 15 minutes) 

 

By setting up the scheduler, the activated tasks will automatically run in the background. 

 

Tasks are executed per predefined order:  

1) The Oxatis orders are downloaded. 

2) Oxatis orders are exported to Sage. 

3) Sage articles are imported to the DataPlug. 

4) Images are transferred to the Oxatis site. 

5) Articles are uploaded to the Oxatis site. 

6) Sage Customers / contacts are imported to the DataPlug. 

7) Customers / contacts are uploaded to the Oxatis site. 

 
When the scheduler is running, you will find in the sub menu DataPlug Tasks  in the option Task Scheduler  the running 

tasks and the Task history.  

 
 

 
 

Viewing the running tasks: 
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 Viewing executed task history: 

 

 

 

 
 

 

It is possible to close the DataPlug by clicking on the "x" in the main application window and leave it running in the 

background. An icon will appear in the Windows task bar. 

 
 

 

 

Right click on the DataPlug icon to: 

 open the DataPlug 

 exit the application  
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4. Importing Sage Articles 

Selecting articles and images in Sage 100 
 

1. The Link for Sage proposes to upload articles with the following criteria: 

 The parameter "Published on the Website " must be checked. 

 The "shut down" articles in Sage, are not "visible" on the Oxatis site if the option is checked. 

  "sales parts list / assembly" articles including a maximum of 10 components in varying quantities. 

 Articles with a maximum tax rate corresponding to the VAT and a tax rate / related article corresponding to 

the WEEE or environmental taxes 
 

2. The connector does not upload these articles or parameters: 

 The type of articles "sales parts list assembly" and "linked article" (excluding management products WEEE) 

 articles that use the same range title in range1 and range2 

 Articles with more than one packaging and their specific rates 

 The options "Calculate the selling price / cost price", "sale debit", "charge / net weight" 

 

3. Pricing for articles on the site can take in account: 

 The discount rate of the customer file 

 The customer's discount rate on article families 

 Price and discount rate for the price category of the customer 

 Price and customer article discount rate (special price) 

 

 

4. Pricing of the following articles are not supported: 

 The discount rate of different rate categories entered at the article family 

 

 

5. Below is the list of Oxatis fields associated with the Sage Link:  
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6.  

 

Oxatis Sage 100 Trading i7 
Association 
automatique 

Association 
manuelle 

Item Code Reference    
Name Article name    
Name of the first category Choice in the DataPlug    
Name of the second category Choice in the DataPlug    
Name of the third category Choice in the DataPlug    
1st option type  Title 1st range type associated with the article.    
2nd option type Title 2nd range type associated with the article.    
Name of the 1st option  Title of this item in the 1st range.    
Name of the 2nd option Title of this item in the 2nd range.    
Code of the 1st option  Internal number for the item in the 1st range.    
Code of the 2nd option Internal number for the item in the 2nd range.    
Stock Quantity Quantity in the selected warehouse.    
Quantity alert Minimum quantity of the selected warehouse.    
VAT rate Rates associated with Tax Code 1, Tax Code 2 or tax code 3.    

Description 
The glossaries connected to the article or the selection of a column of the article table 
(the free information fields). 

   

Detailed description 
The glossaries connected to the article or the selection of a column of the article table 
(the free information fields). 

   

Delay availability Delivery Time    

Environmental tax 
Choice of a tax category corresponding to environmental tax or selecting a column of the 
table section (the free information fields). 

   

Price 1 excl. VAT Choose from one of the 32 price categories.    
Price 1 incl. VAT Choose from one of the 32 price categories.    

Price 2 excl. VAT Choose from one of the 32 price categories.    

Price 2 incl. VAT Choose from one of the 32 price categories.    

Price 3 excl. VAT Choose from one of the 32 price categories.    
Price 3 incl. VAT Choose from one of the 32 price categories.    
Price 4 excl. VAT Choose from one of the 32 price categories.    
Price 4 incl. VAT Choose from one of the 32 price categories.    
Price 5 excl. VAT Choose from one of the 32 price categories.    
Price 5 incl. VAT Choose from one of the 32 price categories.    
Price 6 excl. VAT Choose from one of the 32 price categories.    
Price 6 incl. VAT Choose from one of the 32 price categories.    
Price 7 excl. VAT Choose from one of the 32 price categories.    
Price 7 incl. VAT Choose from one of the 32 price categories.    
Price 8 excl. VAT Choose from one of the 32 price categories.    
Price 8 incl. VAT Choose from one of the 32 price categories.    
Price 9 excl. VAT Choose from one of the 32 price categories.    
Price 9 incl. VAT Choose from one of the 32 price categories.    
Price 10 excl. VAT Choose from one of the 32 price categories.    
Price 10 incl. VAT Choose from one of the 32 price categories.    
Weight Gross or net weight when billing / weight net in the article file.    
Main image Note: weight is expressed in grams.    
Main Image Image file name associated with the article file.    
Small picture (Thumbnail) Image file name associated with the article file.    
Brand Choosing a column in the article table (free information field).    
Page title (tag <TITLE>) Choosing a column in the article table (free information field).    
Description (META description) Choosing a column in the article table (free information field).    
Keywords (META keywords) Choosing a column in the article table (free information field).    
Cost Excl. VAT handling additional copies Choosing a column in the article table (free information field).    
Handling Cost excl. VAT 1st copy Choosing a column in the article table (free information field).    
Height Choosing a column in the article table (free information field).    
Width Choosing a column in the article table (free information field).    
Length Choosing a column in the article table (free information field).    
Show this item even if it is unavailable Choosing a column in the article table (free information field).    
Suggest this item even if it is unavailable Choosing a column in the article table (free information field).    
Show availability delay Choosing a column in the article table (free information field).    
Reason of the unavailability Choosing a column in the article table (free information field).    
Display an alert when the item is in stock Choosing a column in the article table (free information field).    
Show stock level Choosing a column in the article table (free information field).    
EAN code Barcode     
Packaging (Price 1) Packaging    
Packaging (Price 2) Choosing a column in the article table (free information field).    
Packaging (Price 3) Choosing a column in the article table (free information field).    
Packaging (Price 4) Choosing a column in the article table (free information field).    
Packaging (Price 5) Choosing a column in the article table (free information field).    
Packaging (Price 6) Choosing a column in the article table (free information field).    
Packaging (Price 7) Choosing a column in the article table (free information field).    
Packaging (Price 8) Choosing a column in the article table (free information field).    
Packaging (Price 9) Choosing a column in the article table (free information field).    
Packaging (Price 10) Choosing a column in the article table (free information field).    
Cost excl. VAT Choosing a column in the article table (free information field).    
Article Status Choosing a column in the article table (free information field).    
Visible 0 to 3 (0 = unknown, 1 = new, 2 = second-hand 3 = refurbished)    
Warranty in months Choosing a column in the article table (free information field).    
Visible Choosing a column in the article table (free information field).    
Prix barré 2 HT Or otherwise depends on the dormant state    
Strikethrough price 1 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 1 incl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 2 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 2 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 3 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 3 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 4 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 4 incl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 5 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 5 incl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 5 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 6 incl. VAT Choosing a column in the article table (free information field).    
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Strikethrough price 7 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 7 incl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 8 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 8 incl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 9 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 9 incl.  VAT Choosing a column in the article table (free information field).    
Strikethrough price 10 excl. VAT Choosing a column in the article table (free information field).    
Strikethrough price 10 incl. VAT Choosing a column in the article table (free information field).    
WebBlock name for the description Choosing a column in the article table (free information field).    
WebBlock name for a detailed 
description 

Choosing a column in the article table (free information field).    

MPN Choosing a column in the article table (free information field).    
External URL Choosing a column in the article table (free information field).    
Features Choosing a column in the article table (free information field).    
Related Articles Choosing a column in the article table (free information field).    
Article addition to Choosing a column in the article table (free information field).    
Lower range of articles  Choosing a column in the article table (free information field).    
Superior range of articles Choosing a column in the article table (free information field).    
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7. The article import wizard proposes two options: 

 

Choose from the menu Connectors / Sage Trading i7  DataPlug the option Import articles. 

A wizard will appear and guide you through the setup of the to be imported data. 

 
 

 
 
 

 
It is advisable to import articles before importing customers. 
Only customers associated with price categories selected at the article importation are processed. Adding price categories 
or a changing the order in which Oxatis prices are associated are considered. 

 
 

 

Step 1 - You can select: 

 The different warehouses to which the articles you wish to import belong to (the stock of 

selected deposits will be accumulated for each article. This is the amount that it will be 

possible to order online). 

 The type of article: active, shut down or all. 

Articles that are shut down by default will be visible on the Oxatis site unless the box "Make 

shut down web articles invisible" is checked. 

 The families of products that will be imported (by default all families are considered). 
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Step 2- It is possible to also: 

 Ignore the published parameters on the e-Commerce site. 

 Enter a range of article codes and / or select a data range from a free field of the article table 

in Sage. 

o The entered articles codes must exist (the wildcard Character is not supported, as 

full article codes must be provided). 

o The codes must be entered in alphabetical order (Ex. From AAA to BBB). 

 
In the following example, all active sections of the Sage database with the option "Published on 

the e-Commerce site" will be included in the Oxatis DataPlug database. 

 
 

 
 

  
 

Step 3 - It is possible to also: 

 consider the articles whose stock of the selected warehouse is available. 

 To automatically associate the packaging on different prices checked only if the tab 

Packaging the master record in the Sage software includes a single element. 

 To choose between Real Stock, the Available stock and Forward Stock.  

The available stock and stock futures are as defined in the documentation of Sage software:  

 

Available stock = Real Stock - Stock prepared - Stock booked (countermark) + Stock commissioned 

(countermark) 

 

Forward stock = Real Stock + Quantity Ordered from supplier - customer reserved Quantity - Quantity 

prepared for the customer Order The forward stock is the stock remaining after all received supplier 

deliveries and all delivered customer orders). 

 

Theoretical stock = Real Stock - Quantity ordered by customer + Quantity ordered from supplier. 
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Step 4 - It is possible to: 

 For each of the 10 Oxatis prices (5 standard and 10 with the B2B pack), you can assign, via a drop-

down list, one of the 32 price categories defined in the Sage software. 

 For each of the 10 Oxatis strikethrough prices (5 standard and 10 with the B2B pack), you can 

assign, via a drop-down list, one of the 32 Price categories defined in the Sage software. 

 Import discount rules for each of the price categories in Sage 

 Check "Display strikethrough prices " to make the discount visible. In this case the original price will 

be crossed out and the new promotional price will appear next to it. If you do not check the box 

below, the original price will simply be replaced by the promotional price. 
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 Using Oxatis strikethrough prices can be very useful specially to display the price to a customer that has a lower price, but 

no discount on its price category. In the case of a % discount or special prices for customers of a price category, it is not 

useful to associate strikethrough prices.  The applicable discount rate for the customer is directly applied. 

 
 

For every change in price association at the time of article importation, customers must be imported again so that they 

have the new price. 

 
 
 

Step 5 - There are three possibilities to combine the categories of Oxatis articles (items) 

 Creating an Oxatis category tree using the 4 catalogue levels available in Sage. 

 Assigning an Oxatis category (at the same level without using a tree structure) for each of the 

4 levels in the catalogue. 

 Creating a category of Oxatis articles (items) from the Sage article families (product pages).   

You can skip this step to associate three article categories to other information on the article sheet later. 
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Step 6 - The Oxatis site allows the end user to filter articles on certain technical criteria or 

characteristics. This navigation can rely on free information fields (such as text or table only) indicated in 

each article description. 

 

To import it is necessary to check "Import characteristics" 

 It is possible to combine each free field (Sage) with one or more characteristics in the Oxatis 

sites, which will be displayed at the article description. 

 It is possible to define whether the value of the characteristics have to be translated on the 

Oxatis site or not. 

For example: A colour characteristic, which has "Red" as a value: 

It will be necessary to translate the value "Red" into different languages on the Oxatis site. 

Translate the characteristics in "Commerce > Options Types and select the characteristic you 

wish to translate. Modify and change the values in the "Edit article types" column. 

 
 

 
 

Before you can translate the characteristic’s value, you must first import it in the in the main language to the Oxatis site. 

 
 

The "public name option type" can also be translated without further impact because the DataPlug is selects the internal 

name of the characteristic. 

 
 
 

 

 
 

 You can import multiple characteristics per Sage free field, this requires separating each characteristic value with the 

predefined separator used in the article upload, which is "; " by default. 

If a value is found to be invalid, it will not be imported. 
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Step 7 - Associating the VAT rate to Environmental taxes 

 The Oxatis site applies the VAT rate for each of its countries based on the  category selected 

in Accounting.  Prices in Oxatis are based on excl. VAT rates. Associating the VAT rate with the 

chosen accounting allows the system to calculate the excl. VAT price when entering a incl. 

VAT price. 

 It is possible to assign the environmental tax linked to articles (see chapter  8 Management of 

the environmental tax) or tax rates selected from all taxes collected and type Quantity U in 

Sage.   

 Only articles with a single VAT (+ possible environmental tax) rate are imported. 

 

 
The final step of this wizard allows you to link other information to the article description page (Sage) in the environmental 

tax field (Oxatis). 

 
 
 

 

 

Step 8 - The two descriptions of the article / item (Oxatis) may be associated with glossaries attached to 

article sheets (in detail article Sage> Description> Glossary) with the possibility to mention a validity 

period. You can also disable the automatic association of the article's name and family to associate 

other article table columns, in a later step of this wizard. 
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Step 9 - The image associated with the Sage article sheets can be retrieved from the OXATIS site. The 

image format can be kept or may be automatically adapted to customised or recommended dimensions 

for the site. If it is of sufficient quality, the same image can be used to generate the main image, 

thumbnail and zoom image.  

 

 

 
Check the Sort images by category to gather images imported as one image category. 

 
 
 

Check the Import Images box to download the images in the article sheet Sage> Free fields> Photo (this photo is stored in 

the Sage multimedia directory). 

In case you wish to have multiple images per article, it is better to import images placed in a directory, and associate images 

to article in Sage. This is done in the menu or button "Import images" of the DataPlug (excluding Sage Link). Refer to the 

online DataPlug help file to verify compliance with the import conditions, including the names of the image files. 
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Step 10 - At this stage, all the data in the article/item page in Oxatis which are not automatically 

associated are proposed to associate them with the Sage article page, including free information fields. 

 Note: The associated fields must be of the same type (character string, date, whole or real).  

 The meaning of the names of table fields Article (F_ARTICLE) can be found in the structures 

documentation file provided by Sage.  

 

 
 

Step 11 - In this penultimate stage, the number of records matching the selection criteria for articles are displayed prior 

to integration in the DataPlug database.  
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Step 12 - : The article importation results (Sage) results are displayed with the number of records 

imported or updated in the DataPlug database. 

 
 

 

 
 

 

 

By clicking on Finish, all import parameters (article data association Oxatis/Sage with the selection 

criteria) are saved. They will be used in automated synchronisations in the Sage Link Configuration 

menu. 
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Viewing articles and images imported into the DataPlug 
After finishing the Sage article import Wizard, the main application screen refreshes and displays the number of 

articles and images imported or updated in the DataPlug.  

  

 

 

The number of articles correspond to the "published on the Website" articles, excluding not managed articles ("Sales 

assembly parts list") but by adding different versions of the articles in the Sage range that will appear in the form of options 

on the Oxatis site.  

  

 
 

 

You can access this data from the View menu or by using the search function  in the DataPlug in products before 

uploading everything to the Oxatis site. 

 

 

 
 

 

 View Prices tab in the list of articles. 
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 View images tab in the list of articles.  

 

 

 

  Miscellaneous where the article and family references can be found in the database  
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 Sage 100 Trading i7 
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5. IMPORTING CUSTOMERS/CONTACTS SAGE 

1. The Oxatis Link for Sage can import customers and contacts provided an email address has been added (both in 

the main page and the contact page). 

It is preferable to use the contact page instead of using the main page which has no first name area that the end 

user or administrator must enter on the site. 

 

2. Below is the list of Oxatis custom fields associated with the Sage Link: 

 

Oxatis Sage 100 Trading 
Association 
automatique 

Association manuelle 

Title Title of the contact.    
First name Contact first name    
Name Contact name or account.     
Email Email of the contact or account.     
Password Choosing a table column from the customer account (free information field).    
Company Name of customer account.    
NII ID    
N° de SIRET Note: Number must contain less than or equal to 16 characters.    
VAT number VAT number:    
Telephone Contact phone number or customer account phone number.    
Fax Fax contact or account.    
Secondary phone number Cell phone contact    
Subscribed to the newsletter Choosing a table column from the customer account (free information field).    
Address Main address and its complement for the customer account.    
Postcode Postcode in the main address of the customer account.    
City: City of the main address of the account.    
State, County or Province Region / Country address main account.    
Country Country of address main account.    
Company (delivery address) Customer account name for the main delivery address.    
Delivery address Main address and its complement for the customer account.    
Postcode (Delivery Address) Postcode in the main address of the customer account.    
Country (Delivery address) Country in the main address of the customer account.    
State, County or Province (delivery 
address) Region / Country main account address.    

Telephone number (Delivery address) Telephone number in the main address of the customer account.    
Debit customer Choosing a table column from the customer account (free information field).    
Article discount Discount rate    

Cart discount % 
Choosing a table column from the customer account (free information field: General 
discount). 

   

Price Customer account Price category    
Category 2 Note: This price category must be associated with one of the 5 prices in Oxatis.    
Category 1 Choosing a table column from the customer account (free information field).    
Category 2 Choosing a table column from the customer account (free information field).    
Category 3 Choosing a table column from the customer account (free information field).    
Category 4 Choosing a table column from the customer account (free information field).    
Birth date Choosing a table column from the customer account (free information field).    
Comments Choosing a table column from the customer account (free information field).    
Loyalty scheme Choosing a table column from the customer account (free information field).    
Subscribed to SMS campaigns Choosing a table column from the customer account (free information field).    
Custom Field Text 1 Choosing a table column from the customer account (free information field).    
Custom Field text 2 Choosing a table column from the customer account (free information field).    
Custom Field Text 3 Choosing a table column from the customer account (free information field).    
Custom Field text 4 Choosing a table column from the customer account (free information field).    
Digital Custom Field 1 Choosing a table column from the customer account (free information field).    
Digital Custom Field 2 Choosing a table column from the customer account (free information field).    

 

 

Selecting customers/contacts Sage 100 
 

Choose from the menu Connectors> Sage 100 Trading i7 v8.0 in the DataPlug the option Import 

customers/contacts (Sage) to the DataPlug.  

A wizard will appear and guide you through the setup of the data you want to import. 
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Step 1 – you can: 

 choose the data you wish to import: all customers and contacts, active customers or contacts. 

 filter the type of customer: active, sleep-mode or all. 

 select customer account numbers to import (by default all accounts are selected). 

 import additional delivery addresses (for contacts only), up to 50 addresses per contact. 

 

 

 
 

 

 
The Identification tab includes the type "customer"  
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In the Contacts tab, there is the type of customer "contact" with the service attached 

 

 

 

You can import additional delivery addresses for contacts only. It is therefore advisable to work in Sage with users in 

the tab "Contacts" and recreate the mail in the "identification" tab in the "contact" tab so delivery addresses can be 

retrieved. 

 

 

 

 

 

 

The "Deliveries" tab includes the addresses that will be imported (50 maximum) for each contact 

 

 

 

 Delivery addresses are ignored for countries whose ISO code is not defined. 

 

 

 

 

Step 2 - This step is only available when importing contact information. You can: 

 Select the services to import. 
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Step 3 – You can: 

 import discounts per article family and special prices 

o  set the priority for discounts: 

 discount item 

 family discount 

 user discount 

 Accumulated discounts 

 successive application of discounts (Cascade Mode) 

 check "Show strikethrough prices " to make the discount visible. In this case the original price 

will be crossed out and the new promotional price will appear next to it. If you do not check 

the box below, the original price will simply be replaced by the promotional price. 

 automatically associate the Oxatis price with the Sage price category. 
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 Associating the Oxatis prices to their category is important because within the Oxatis site, the customer Price and 

Category are two different concepts that are associated in Sage in properties. 
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Step 4 - At this stage, all the Oxatis fields which have not been automatically associated are proposed so 

you can link them to one of the columns of the customer table (Sage), such as the free fields. 

 Note: The associated fields must be of the same type (character string, date, whole or real).  

 The meaning of field names from the table of third party accounts (F_COMPTET) can be found in 

the documentation of the file structure provided by Sage. 

 
 

 
 
 

 
 

 Adding new columns to manage custom fields from the Oxatis user profile 

 4 custom "text" fields: " Custom Field Text 1 "," Custom Field text 2 "," Custom Field Text 3 " and " Custom Field 

text 4 ". 

 2"Digital" custom fields type: "Digital Custom Field 1" and  

"Digital Custom Field 2". 

 1 custom field type "Date": "Custom Field Date". 
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Step 5 - In this penultimate stage the number of records matching customer accounts selection criteria 

are displayed before the final data import. 

 

 
 

 

 

The importation results of Sage customers / Oxatis users are displayed together with the number of 

records imported or updated in the DataPlug database. It identifies any anomalies encountered during 

the processing. In this example, it is necessary to correct a misinformed email address in the Sage 

database.   

By clicking on the button "finish" all import parameters, selection criteria and the association of Oxatis 

fields with those of Sage are saved. 
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Viewing the customers / contacts imported in the DataPlug 
By closing the Import Wizard for customers / contacts (Sage), the main application screen refreshes and displays the 

number of customer/contacts imported into the DataPlug. 

 

You can view this data from the menu View the DataPlug or search  in users before uploading it to 
the Oxatis site. 
 

 

 
 

Select the main information tab in the user list. You will find in this sheet the references of the customer page from 

Sage. You will also find the Oxatis ID when the contact has been uploaded to the Oxatis solution. 

 

 
 
The Address tab in the user list 
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The Delivery address tab in the user list. 
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6. EXCHANGING DATA WITH THE OXATIS SITE  

Uploading images, items and users 
 
The various Sage data uploads to Oxatis (images, items, users) can be performed separately or globally by selecting all 
from the upload menu. 

 

 

 

The upload Wizard shows the number of records (images, articles and users) to upload to the Oxatis site. 

 

 

By clicking on the button "Next " the wizard uploads the data to the Oxatis site. 
You can interrupt the upload in progress at any given time and resume it later. 
At the end of the upload, the wizard informs you of the number of uploaded files.  
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Viewing the items and users imported on the site Oxatis 
 

 Log onto the Oxatis site 
 

 
 

 Choose Users in the Marketing menu to consult customers/contacts uploaded from the DataPlug. 
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 Select items in > Commerce to view items and images uploaded from the DataPlug. 
 

 
Above: the list of items and their respective properties. 

. 
 

You can customise the column display and filter the content of the list using the button and select the column 

titles and completing the information for the filters you wish to apply. 
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Connecting Sage price categories with Oxatis prices 
 

 Select items in Commerce to view items and images uploaded from the DataPlug.  

Then Component - Properties 

 If several price categories have been selected, select "Yes" for the implementation of the Multi-Price 

Management 

 We now associate the imported price categories from Sage during item import with Oxatis prices 
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 Resume the order defined at the time of the item importation on the Oxatis site 

 

 

 
 

 

 
 

 Prices are defined in the article file 
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 Linking a user / customer to a price and a customer category is relative to its price category. 

 

 

 

 It is possible to link the user to other customer categories at the final stage of the Sage Link wizard 
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Overview of customer orders in Oxatis 
 

In the example below, two customer/user orders on the Oxatis site, will be uploaded to the DataPlug and then to Sage. The 

first order bearing the number 14312017 is displayed in price excl. tax, the second bearing the number 14312037 is 

displayed in price incl. tax.  

 

You can find the orders in Commerce> Order Tracking: 
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Retail orders No. 14312017 (excl. VAT) and No. 14312037  (incl. VAT): 
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Downloading Oxatis orders to the DataPlug via the Download menu imports the customer orders from the Oxatis site and 

saves them in the DataPlug. 

 

Select Download from the main menu and select Orders.  

A wizard appears and shows you the customer orders download settings. 
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Step 1- Select a date range for which you want to import orders with the possibility of taking into account manually 

validated orders. 

 

Only orders with the status of Payment Confirmed, will be downloaded. However, you can choose another payment 

status (Call the payment processor, Payment in process or Refused payment) and the dates for changing the status of 

payment. 

 
 

 
 
Orders from Credit customers are Enabled and aren't validated on the Oxatis site.  Credit customers have no payment 

step in the order process on the e-Commerce website and pay according to their customary conditions specified in 

Sage. 

 
 
 
Step 2 - The number of orders to download appears, click on "Next " to launch the download.  
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After the download  you see the number of orders imported. 

 

 
 

 

7. EXPORTING ORDERS TO SAGE 

After closing the order download wizard, the main application screen refreshes and displays the number of orders 

imported into the DataPlug. 

 

Select View orders to view the orders downloaded from Oxatis site. 

Display the tab Total: 
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Display the tab Details wherein you will find the items present in the selected order. 

 

 
 

Exporting orders to Sage  
Exporting Oxatis orders to Sage 100, entails creating new purchase orders in the Sage file.  

Select Exporting orders towards Sage from the menu Connectors> Sage 100 Trading i7 in the DataPlug. A wizard 

appears and shows you the settings required for exporting your orders.  

 
 

 
 

 
 

Step 1- By default, all non-exported orders present in the DataPlug are proposed for export to Sage. You can 

select another date range and optionally upload earlier exported orders.  
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Step 2 - You must select the following parameters: 

 The selected warehouse will be attributed to new orders you are about to create in the Sage 

database. 

 It is also possible to use the warehouse attached to the customer. 

 The Special instructions and any further information on the delivery of the Oxatis order may be 

associated with the columns of the sales documents. 

 Oxatis payment methods should be associated with the payment methods defined in the Sage 

software. ("Standard" Oxatis payment methods will be associated with the payment method 

"Other" in Sage.) 

 Check the corresponding boxes to add text attributes and comments in the order lines. 

 The discount code section is mandatory, it will be used to manage the basket discount for an Oxatis 

order as an additional line (Discount and refund) in the newly created order in Sage.  

 
 

 
 

 

Step 3 - You can associate the contact and delivery address of Oxatis orders to free fields in the Sage customer 

order. 
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Step 4 - You must associate each of the Oxatis delivery methods to a Sage shipping method associated with a 

postage item. 

It is also possible to delete associations by right clicking on them. 

 
Step 5 - Associate the Oxatis order sources with the Job codes in Sage 
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Step 6: 

 A checkbox allows you to display the first and last name of the contact as well as the customer's 

name in uppercase. 

  The reference to a paying customer account can be defined in case you want to assign the same 

account for all the new customer accounts created in the Sage software. 

 You can also change the prefixes of potential new accounts 

 The collective account and the default payment method will be used to create new customers in 

the Sage Software database. 

 The date of birth and password will be assigned to free fields of the customer page (Sage).  

 The assignment of an account Sage separate centralizers (i.e. WebUK) for all domestic sales, EU 

sales excl. VAT, EU sales incl. VAT and export activities. All with separate delivery addresses for 

each Oxatis user or for all users or only for customers who are not on "credit". 

 

 

            Only order delivery addresses will be exported 
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Step 7 : 

 You can assign the accounting categories by sales types: Domestic, EU excl. VAT, EU incl. VAT and non-

EU. 

 You can select the order numbering stub in the Sage software. You can also change the prefixes of 

possible new items and choose the item family that will be associated with them. 

 

 

 

 

 

 

Trade customers within the European Union which have entered/retained their VAT number on their Oxatis order will be 

associated with the accounting category of "EU excl.VAT". In the absence of an Intra-community VAT number, it is the 

accounting category of "EU incl. tax" that will be associated with the customer. 

 

 

Assigning a customer to your country, to the EU or outside the EU area depends on the ISO country code of the 

delivery address or if not provided, its billing address. 

 

 

 

The optional automatic coding of the Sage Company settings overrides the prefix set in the Sage link. 
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Step 8 - The wizard calculates the number of orders for export before proposing to export. 

 

The result of the export of orders to Sage is displayed with the number of records added or created in Sage. You can copy 

the contents of the Results tab to the clipboard to retrieve it for later consultation of all orders and other new records 

created in Sage. 

By clicking on Finish, all export parameters (the association of fields and customer selection criteria) are saved. 
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View customer orders in Main information where you can find the Sage order number  
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Displaying orders in Sage Trading i7 
 

Consult Purchase orders created the DataPlug 

Select Sales Documents in the menu and filter on order. 

 

 List of orders exported with the DataPlug. 
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 Consult the Oxatis order excl. VAT, which number is in the reference field of the Sage order. 

 

 

 
 

 

 

In this order a new article line appears with ZREMISE as reference. This code was attributed during the 

second step of the export wizard which represents a global discount (Basket discount) applied to the Oxatis 

order.  
 

 Valuation of the Oxatis order displayed excl.VAT  
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The document’s valuation gap zone can be filled to register rounding errors. Transport costs VAT calculation is 

computed separately from the rest of the order. This gap will be processed accordingly to Sage’s gap management 

settings.  

 Viewing an order incl. VAT with of which its number can be found in in the reference field in SAGE 

 

This order contains a line with the discount set in the wizard. This corresponds to an overall discount (or 

basket discount), of which the calculation of VAT and the accounting stem from the article settings. 
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 Article accounting settings ZREMISE used: 

 

 
 Valuation of the Oxatis order incl. VAT. 
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 The valuated order includes the delivery costs that match the shipping method of the order in the Sage Link 

to which is assigned a delivery item. 

logistical parameters of Sage shipping methods files here using the ZPORT item 
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  The Oxatis order is paid with cheque 
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Displaying new customers in Sage 
 

Exporting customer orders to Sage allows you to create new contacts in the Sage database. 

Below an example of a user profile created on the Oxatis website and then exported to Sage. 
 

 

 Main tab of the user profile created on the Oxatis site 

 

 

 
 Billing address tab in the user profile. 
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 Delivery address tab in the user profile 

 

 

 When exporting an order by a new customer, Sage will inform you that a new customer has been 

created in the Sage. 
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You can view the new customer in Sage. 

 

 Tab " Identification "OXCLI1 new account. 
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 Tab "contacts " of the OXCLI1 new account. 
 

 

 

It is preferable to use contacts instead of the main page which has no first name area that the end user or administrator 

must enter on the site. 
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 Delivery addresses attached to the OXCLI1 account. 

 

 

 

 If customer coding is set to Manual, new accounts will follow the numbering in Sage Trading i7. 
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8. ADVANCED CONNECTOR FUNCTIONS 

Price management 

General information on price management in Sage. 
The price and discount management in Sage 100 i7 are both precise and adaptable. The data storage and calculation rules 

differ from the Oxatis Solution. 

The Oxatis e-Commerce site is directly accessible to the end customer who benefits from its price conditions without being 

able to manipulate the different price priorities and discount levels, especially in the case of conflicting discounts. 

The role of the Oxatis Link for Sage is to integrate data from Sage and to transfer them to the Oxatis fields so the shopping 

cart algorithms can process them. 

The cases the Link treats are described in this section. Cases that are excluded from the Oxatis Link for Sage are also 

addressed to ensure you understand the extend of the functionalities that the Oxatis site and the Link for Sage offer. You 

will find a summary of at the end of this chapter. 

 

The selling price is set in the article: 

 1 reference selling price 

 1 selling price for each price category (By default the basic price) 

 1 selling price or special price for each customer (optional but is a priority) 

. 

The selling price of an Oxatis item is primarily the customer’s's special price or that of its price category. 

 

The discount is set (always optional) at the: 

 Customer file 

 Article families (For the customer or its price category) 

 Article file (for the customer or its price category) 

This order follows the logical order of discount application from the general (customer discount on selected items) to 

special(special prices).  

For example: 

 This customer CARAT enjoys a 10.5% discount on all items for all BIJOU SA orders. 

  The customer also benefits from a 25% discount on all items of the BIJOUXAR family (all silver jewelry), against 

only 10% for other clients of this price category. 

 The customer (CARAT) benefits from a 50% discount on Article BAAR01 (Silver Ring of happiness) while other 

clients of the price category only receive a 10% discount. 

When entering a sales document, the order in which discounts are applied usually is the exact opposite: 

 Article discount (customer discount or its price category) 

 Article family discount (for the customer or on its price category *) 

 Customer discount 

In our example the customer CARAT buys therefore Article BAAR01 with 50% and not 10% or 25% or 10.5%. 

This is exactly what will happen if a CARAT user orders online from the oxatis site. 
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Volume discount grids, net discount prices, incremental or "without discount" are also managed here  

 

* Any possible restrictions are presented below: 

 Format of amounts and quantities 

Sales prices and discounts are available on 2 decimal places and calculated on 3. 

Quantities are rounded. 

 The discount that is applied in case of conflicting discounts 

The Oxatis algorithm is variable and depends on the priority you've chosen namely " Article discount, Family discount, User 

discount, Accumulated or Cascading The manual selection inapplicable in eCommerce is the general case.  

Some companies may change the priority applied to discounts or base their discount policy on accumulative or a  cascading 

priority in particular to allow for trade negotiations at various levels. 

Window and possibility of setting "Discount to apply in case of conflict" Sage: 

 

 

Determining the "Article discount" priority in the Oxatis link for Sage: 
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The priority level informed during import customers will be uploaded to the Oxatis site, which can be found in Commerce > 

Item discounts > Component - Properties  

 

 

 

The Sage selection window that appears in the sales document entry in the case of conflicting discounts summarises the 

origins of the of conflict and the discount application priorities.  
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This window from the "Manual Selection" or when you encounter a multiple conflict not managed by Sage software is not 

possible on the Oxatis site, hence the application of the following rules:  

 

Discount levels 
Applied 

 

ARTICLE X X   X  Special price or default price category 

FAMILY X  X  X X Customer discount on the article family 

CUSTOMER X   X  X  
 

Unlike Sage, which doesn't apply a discount if no article discount is found and there is a conflict in discounts between article 

family and the customer file (last column), Oxatis applies the family discount.  

 

 Article family discount for a price category 

Discounts and discount grids in the group " Article family/Price category" have no equivalent on the Oxatis site. This level is 

recovered during the creation of an article to the couple "Article /price category" in Sage this setting is maintained if it 

hasn't been changed after creation. A control phase and the use of the "Updating prices" in Sage indirectly help to have a 

website displaying identical behaviour to that of the ERP. 
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 Discounts in %, units and amount 

 In addition to simple discounts in %, Sage 100 also allows for unit discounts entry (U) or Flat (F) Or even formulas 

inside rebate grids. Only the simple % discount is treated by the connector. In the following case, only the first line 

is interpreted by the connector and transmitted to the site. 

   

 



 
Sage 100 Link i7 SQL Server 

 Business Object Extension Pack 
Version 6.40 

9 janvier 2017 

 

Page 78 / 113 

 

 

 Price categories and multi-pricing 

It is possible to select 10 Price categories for online sales on 32 in Sage. If more than 5 categories are selected, the 

B2B pack must be enabled on the Oxatis site. 

In the case of a multi-rate management, the function must be activated on the Oxatis site and the mapping order 

from "Prices" in Oxatis to "Price categories" in Sage, in the same order as specified in the connector. 
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Import articles and price categories 
 Mapping article prices 

Oxatis and Sage price can be mapped in any order. The important thing is to keep the same order as on the multi-rate 

settings on the Oxatis site. 

The option " Import Rules discount for each of the tariff categories "Is used in addition to the price the rate category, 

recover discounts and associated grills. 

The association with the concept of strikethrough prices in Oxatis is not efficient if the above option is not selected in which 

case the strikethrough price will be considered as the base price compared to the price in the category. The difference in % 

is the customer discount. 
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Tab " Identification " of the article file in which appears the different article prices for each price category: 
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Price detail (current) of an article for a price category:  

 

 

The different types of applicable and discounts possible: 

 

 

Transposition in the article description in the Oxatis site including the concept of article families in Sage for pricing: 
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The different types of discounts corresponding to Sage discounts plus the concept of "discount on articles, article 

categories, brand or category combination article / brand" corresponding to a promotional discount on an item (Oxatis) 

 

 

The different types of discounts corresponding to Sage discounts plus the concept of "discount on articles, article 

categories, brand or category combination article / brand" corresponding to a promotional discount on an item (Oxatis) 
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Customer import, customer discount, family discounts and special prices 
The option " automatically map the price (Oxatis) with the price list (Sage) "links the customer with his Oxatis price 

relative to its price category 

The option " Import product family discounts and custom prices "Retrieves discount rates and linked to the customer 

(customer card, rebate per family article, except for price): 

 

 

Family discount tab 
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Tab Special Price list in Sage 
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Detail of a "Special price" for a customer: 

 

 

Detail of an article family discount for a customer list: 
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Transposition of the family discount on the Oxatis site: 

 

 

Transposition of an article discount for a customer: 

 

 

 

Transposition of the discount of for a Sage customer "Article discount" that is to say to the web order line: 
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The applicable overall discount on the entire basket is "mappable" (mapping) at the final stage of customer/user import: 

 

 

Example of a combination of an overall promotional discount type from a free information field: 
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Viewing the overall discount once imported on the site: 
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Summary Oxatis / Sage prices 
The features in italics are not supported in this release.  

 

 

 

Price and Discount Management 
Oxatis Link for Sage e-Commerce BtC, 
BtB, BtE 

Sage sales management 
Back office 

Prices 
5 or 10. 

32 
(Without / with pack BtoB) 

Discount format % %, U, F 

Discount type 

Simple Simple 

Excl. Discount Excl. Discount 

Quantity discount (up to 10) 
Quantity discount 
(unlimited) 

Discount by amount (up to 10) 
Discount by amount 
(unlimited) 

Net price (up to 10) Net price (unlimited) 

Discount levels 

Customer Customer 

Article family / Customer 
Article family / Category 
Pricing 

Article / Category Pricing Article family / Customer 

Article / Customer Article / Category Pricing 

  Article / Customer 

Priority and conflicting discounts 

Article Manual Choice 

Family Article 

Customer Family 

Cumulation Customer 

Cascading Cumulation 

  Cascading 

  ... With Category / Family 

 Priority discount conflict  
Application by priority  

No discount  
Article family before Customer 

Sale & Promotions 

Updating prices (Oxatis or Sage) Manual 

Promotion (Oxatis) Updating prices 

Strikethrough prices (Oxatis) Sale & Promotions 
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Price and discount management with an article priority (in %) 

 

 

Parts list management 
This section is dedicated to the management of such items "Parts Lists" in the Sage software. 

 The cases the Link treats are described in this section. Cases that are excluded from the Oxatis Link for Sage parameters are 

also addressed to ensure you understand the extend of the functionalities that the Oxatis site and the Link for Sage have to 

offer. You will find a summary at the end of this chapter. 

 

 
 
These cases are treated: 

 Manufacturing 

 Parts list Sales/assembly Fixed (Allow manual modification" unchecked) 

 Parts list "Sales /assembly /compound " Variable ( "Allow manual modification checked) only when catalogue 

configurator is activated (optional) on the Oxatis site 

 

Non-supported cases for this version: 

 related articles 

 Parts list "Sales/Component" 

  Parts list "Sales/assembly" with a minimum of 10 component items 

 
 

Parts list "Sales/assembly" fixed Sage Pack and fixed Oxatis Pack 
 

A Fixed Pack is an article including other previously determined articles. 

Look at article ENSHF in Sage with: 
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 Selling price excl. VAT £2500. 

 A VAT rate of 20%. 

 Parts list: Sales/Assembly (Fixed) 

 Containing multiple articles 

 

 

Details of the parts list Sales/Assembly: 

 

 

Detailed components of the parts list (fixed for unauthorized modification of the composition input) – the % of distribution is important for 

the recovery of components in the sales document: 
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The import process is identical to other articles.  

 
Go to Connectors/Sage Trading i7 version 8.0  in the DataPlug choose Import products 
A wizard will appear and guide you through the setup of the data you want to import. 

At the end of the article import wizard (Sage), the main application screen refreshes and displays the number of articles 

imported or updated in the DataPlug including the parts list Sales/assembly articles. 

You can view this data from the View menu or from the DataPlug group button before transferring all to the Oxatis site. 
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Overview of "Suggestive selling & Characteristics" tab in the list of articles of the DataPlug with the pack components: 

 

 

 

 

At the exit of the article transfer to the Oxatis site, the article is available on the latter.  

In items then the menu Commerce to view the articles transferred from DataPlug: 
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The article is well regarded as a pack containing items. 

After buying an article on Oxatis, download the order on the DataPlug, then export it to Sage. 

 

To check the order documents created via the link for Sage: Go to Sage’s Process menu, then “Sales Document”, and 

“Order”. In this order is a new article line with the Sales/assembly parts list and the relevant items. 

 

Here’s the order once downloaded into the DataPlug: 
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Once exported to Sage: 

You will find in this order a new article line with the sales/assembly part list and the articles that are part of it. 

 

 
 

 

Line discounts have a  Fixed (F) type. Unit discount (U) – notably serialised or batch articles – are also written as “F” for the 

whole batch or serial numbers.  

Summary of the type article parts lists Oxatis and Sage 
The features in italics are not supported in this release.  

 

Parts list management 
Oxatis Link for Sage e-
Commerce B2C, B2B, B2E 

Sage Back office 

Parts list type 

None None 

Manufacturing Manufacturing 

Sales/assembly Sales/assembly 

  Sales / component 

  Linked articles 

      

Number of components 

10 max. Unlimited  

(1st article level = not 
manufactured article 
components) 

(Up to 10 levels) 

Number of components per composed 
product 

Variable 
Variable 

Fixed 
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Discounts valuation Sage order Flat rate (F) 
Flat rate (F) 

Units(U) 
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Language management 
 

To work with more than one language in an Oxatis site, you must duplicate the items in the desired languages to customise the 

properties related to each language (descriptions, categories, price, etc ...). This means that when you import articles from/to? Sage, 

each article will be treated as a stand-alone article for each language selected in the Oxatis Link Configuration. 

 

Let's look at an example: article BAAR01 is part of the file bijou.gcm Sage Trading 100. 

Indeed, if we consult the tab descriptions of the record, we find that the wording of the article is defined in English for language 1: 

Silver ring. 
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In Connectors / i7 Sage Trading / Configuration DataPlug in the menu and select the tab other settings. 

Check the box Activate language management for articles and check the languages you want to manage in the site Oxatis. 
 

 

  

 

  

When activating a 2nd language, it is advisable to keep the tax configurations of the country of the site. If your business is 

based in France, but sells items internationally and have translated your site in English but still work within the French tax 

system: Customers who have a VAT number will be exempt from taxes. 

 

 

Choose from the menu Connectors / Sage Trading i7  DataPlug the option Import items. 

When launching the Import articles Wizard, a dialog box will allow you to select the language in which you want to import the items. 
  

 

The first page of the wizard displays the flag corresponding to the language and its ISO code in the window title. 

  

 

 



 
Sage 100 Link i7 SQL Server 

 Business Object Extension Pack 
Version 6.40 

9 janvier 2017 

 

Page 101 / 113 

 

 

 

The article in the primary language in Sage being duplicated and renamed for each alternate language, the box 'Dont 

automatically fill the article’s name  
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Map the English language label in the column AR_Langue1 to Name. 

 

 

By validating the article import, all filled settings are saved for the selected languages. 

 

Then transfer the articles present in the DataPlug to the Oxatis website and view the article BAAR01 from the back office. 

 

 

 

 

Note we now have 2 different articles with the same code BAAR01 but for two distinct languages with their own name and whose price is displayed in Pound Sterling. 

 

 

When exporting orders, the choice of language is also available, so you can set different language parameters. However, 

regardless of the chosen language, the Dataplug will export all pending orders corresponding to the language of the order. 
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Currency Management 
 

 

 

 

To work with multiple currencies, it is imperative to have multiple Oxatis e-Commerce sites, each displayed in their own currency. 

 

 

Let's look at this example: article BAAR01 is part of the file bijou.gcm in Sage Trading 100. 

In the tab Identification of the article file, we can add a new price category for a price in GBP £. 
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We define its price in GBP 200 with a 5% discount below. 
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Start the article import wizard for the site in Pound Sterling. 

In step 10 of the price mapping, associate the newly created price category. 

Here the price category Price in £ of Price 1.  

 

 

Then transfer the articles present in the DataPlug to the Oxatis website and view the article BAAR01 from the back office. 
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Place an order on a site in Pound Sterling with the same article as below: 
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Download this order in the DataPlug and transfer it into Sage 100 Trading 

 

When consulting generated order, you notice two things: 

 The piece is converted in the bookkeeping currency in the folder Sage 100 trading, in this case the Euro.  

 The piece uses the VAT calculation method. 
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The name and the selling price and the currency of the article are those present in the Oxatis back office.  

The currency, Pound Sterling and its present rate can be found in the Sage 100 Trading folder.  
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The shipping costs are also converted into euros. 

 

 

 

 

The down payment is displayed in the same currency as the Oxatis order and its value in euros.  
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